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JOIN THE CLUB...
Welcome to the world’s  

No.1 weekly digital 

photography magazine. 

If you’re already a 

reader, thanks for your continued 

support and involvement; if you’re 

new to Photography Week, you’ve 

come to the right place! In addition 

to expert advice, brilliant tips and 

step-by-step tutorials, every issue 

features interactive galleries of 

brilliant photos, how-to videos on 

essential shooting and editing 

techniques, and in-depth reviews 

of the latest camera kit. 

But that’s not the whole story. 

Photography Week is more than 

a magazine – it’s a community 

of like-minded people who are 

passionate about photography. 

To get involved, just follow any 

of the links below and share your 

shots and comments. 

Jeff Meyer, Editor

W E L C O M E

We’re more than just a magazine – read on and discover the many  

ways you can interact with and enjoy Photography Week

JOIN THE PHOTOGRAPHY WEEK 
COMMUNIT Y AND START SHARING!

FACEBOOK
http://bit.ly/39py9lg

TWITTER 
http://bit.ly/2vGadLP

FLICKR 
http://bit.ly/2VIgsJO
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P H O T O S H O P

N E W S

KEY SPECS CONFIRMED 
FOR ROLLEI 35AF 
Film camera reboot will get a 

35mm f/2.8 lens and autofocus 

F E A T U R E

CREATIVE COMPOSITION 
Learn how and when to break 

the rules for shots that stand out 

P H O T O S

GALLERY 
Our pick of the best reader 

photos from around the world

I N S P I R AT I O N

A PLANET IN PICTURES 
Incredible images from the 2024 

Sony World Photography Awards  
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SUNSET SILHOUETTES 
Shoot and combine images to 

create atmospheric composites
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Produce new backgrounds with 

the amazing AI Backdrop Creator
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Need a lightweight 

and compact lens 

for shooting sports 

or wildlife? We test 

Sigma’s super-tele 

Sports-series optic
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W H AT ’ S  H O T
THE WEEK’S TOP HEADLINES IN PHOTOGRAPHY

SN E W

 ROLLEI 35AF WILL GET A 35MM 
F/2.8 LENS AND AUTOFOCUS

nstant camera brand Mint 

Camera has announced more 

details about its upcoming 

new film camera, the Rollei 35AF, which 

is based on the classic Rollei 35 and is 

due to launch later this year.

Film fans will be pleased to learn that 

the camera, which was first announced 

in 2022, will sport a 35mm focal length 

and a fast maximum aperture of f/2.8. 

Rollei has also confirmed that the AF in 

the name stands for Auto Focus, which 

means modern tech is coming to this 

legend of an analog camera.

In an official announcement, Hong 

Kong-based Mint said: “We believe that 

classics are meant to be cherished, 

and our mission is to preserve the 

essence of this iconic camera while 

incorporating new features that enhance 

its capabilities without compromising 

its unique charm. With the added AF 

and other features, capturing stunning 

analog film pictures becomes effortless, 

quick, and incredibly precise.”

In addition to autofocus, the new 

camera will have a built-in light meter 

and auto modes, making it easy for 

anyone, from beginners wanting to try 

analog photography for the first time 

to seasoned experts, to shoot with it.

While, this is a totally new camera, 

in a full metal body, is looks just as 

stylish as the original, with the bonus 

of some modern tech, and going by the 

official photos and the image samples 

that Mint has shared, this is one retro 

comeback that we’re really looking 

forward to trying out.

As mentioned, the Rollei 35AF is 

due to go on sale later this year, and 

is rumored to cost around $800.

I

Mint Camera confirms key specs for upcoming reboot of classic film model
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CREATIVE COMPOSITIONS
Break the rules, and discover strategies for framing images that stand out 

Words by Kim Bunermann. Images by Divyanshu Verma

ave you ever wondered why 

some photos stand out from the 

rest? Of course, there are plenty 

of aspects that may catch our eye, but 

it’s most likely to have something to do 

with the composition.

With the rise of social media 

platforms, we’ve all seen countless 

photos that have been captured using 

common composition strategies; but,

however impressive or technically 

correct they are, these shots tend to get 

lost in a sea of similar-looking images.

This is hardly surprising, as when we’re 

first introduced to photography, the use 

of classic framing methods is high on 

the list of things we’re taught. Straying 

from this path of tried-and-tested rules 

is not considered an option, although, in 

reality, not every interesting scene can 

be captured at its fullest potential by 

applying these traditional approaches. 

Sometimes, to create unique and 

extraordinary frames, it’s necessary 

to come up with an alternative way to 

consider the visual potential. 

So, it’s time to put the tried-and-

tested strategies, such as the golden 

ratio or the rule of thirds, on hold, 

and learn from compositions of other 

mediums that can help us cut loose 

from the familiar. Exploring the diversity 

of framing in photography starts with 

analysing juxtapositions and new visual 

possibilities that are waiting to be put 

into action. However, not every scene 

will benefit from creative compositions, 

so it’s crucial to not always use them 

as framing tools and, instead, see them 

as a way of considering the possibilities 

when capturing the subject.

In this feature, we will look at the 

importance of captivating framing, and 

discuss why tried-and-tested techniques 

may work against us and restrict our 

creativity as image creators. Over the 

next few pages, you’ll discover various 

creative ways to compose a frame. By 

doing so, you’ll be able to surprise the 

viewer, force them to look closer and 

create a lasting impression.

H

RIPPLE EFFECT

When it comes to composing 

the image in a creative way, 

there are no rules as long as the 

subject gets visually highlighted 

UT R EF E A
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UT R EF E A

ollowing a different approach is a 

good way to break free from the 

traditional rules of photography 

and experiment with compositions that 

go a little further. The rule of thirds is one 

of these well-established compositional 

methods – it involves dividing the frame 

into two horizontal and vertical lines, 

creating four connection points where 

key elements should ideally be placed 

for a harmonic and balanced frame. 

As viewers are accustomed to classic 

compositions like this, intentionally 

breaking these patterns can be a smart 

move. By deviating from the norm, you 

create an unusual image balance and 

dynamic. However, you should still 

activate the rule of thirds grid lines in 

your camera menu. This will help you 

cut loose from old patterns, as you can 

now identify where not to place the key 

features of the scene.

Breaking this composition approach 

is particularly useful to emphasise the 

main subject when distracting elements 

or so-called ‘dead’ space is evident in the 

scene. The latter can be understood as 

‘empty’ space which does not contribute 

to showcasing the subject. To create 

a more focused composition, adjust 

the subject’s position up or down. For 

example, if the main subject is a dramatic 

F

BREAK THE RULES
Use traditional composition rules as a guide, adapting 

them in a way that benefits your subject

SHADOW LAYER

By including shadows 

of all kinds, the scene gains 

individuality and an extra

layer of interest

FIND YOUR 

PERSPECTIVE 

Using a tripod is a great way to 

slow down and refine the process of 

composition. Adjust the height of the 

camera to avoid the common eye-level 

perspective and change the ratio of the 

foreground and background. Experiment 

with different focal lengths, as these will 

affect the compression within a scene. 

For example, using a longer focal 

length will bring elements 

of the scene closer 

together.

sky, shift the focus there to give it more 

space in the frame.

Additionally, you could experiment 

by including unexpected elements in 

your composition, such as a thin strip 

of land at the bottom of the frame. 

Another possible approach is to fill the 

entire frame with just one subject. This 

is especially effective when the subject 

is positioned in the foreground, and this 

way, colour, and structure will take on 

further importance, creating a bold and 

impactful composition.
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UT R EF E A

witching the image orientation 

is a common technique that can 

give your scene a different look. 

For example, a portrait orientation shifts

the focus onto the foreground details, 

while a landscape orientation is best 

suited to highlight frames with strong 

horizontal lines. On the other hand, aspect 

ratios are often overlooked, even though 

they can potentially play a significant role 

in image composition, and have an impact 

on the relationship between the different 

elements in the photo. 

Social media platforms each have their 

own favoured ratio for displaying images 

online, but when it comes to switching 

formats, there are no limits. Here, non-

standard ratios offer the best base for 

eye-catching compositions. Many of us 

rely on cropping adjustments in post-

processing, but something that isn’t often 

taken into account is that most modern 

cameras can produce various ratios in-

camera, instead. Nevertheless, it’s best to 

decide on a specific ratio while shooting 

the scene, as it allows you to target and 

create a composition that favours your 

subject. Go to the camera’s menu to see 

what aspect ratios are available. After 

selecting one, a box with the chosen 

ratio will become visible on your camera 

screen, meaning that everything outside 

of the box will be cut off.

If you want to work with ratios that your 

camera doesn’t offer, add a few strips of 

tape over the rear LCD screen protector 

to give you a view of your desired aspect 

ratio. Bear in mind that different aspect 

ratios have different effects on the frame 

and may be suited to certain applications 

or purposes. You can learn more about 

the benefits of different ratios below.

S

TRY DIFFERENT FORMATS 
Exploring different ratios is a game-changer when

it comes to creating creative compositions

16:9

2:3

4:5

1:1

5:7

1:1 

Simplifies images and 

accentuates minimalistic 

scenes. Evokes a sense 

of nostalgia, as the format 

is similar to that of classic 

Polaroid prints

2:3

The vast majority of 

images have this standard

ratio, which is equivalent 

to the classic 4 x 6in photo, 

the default format of 

35mm cameras.

4:5

Commonly used by micro 

four thirds cameras and 

social media platforms 

such as Instagram, which 

adopted this aspect ratio 

for vertical portraits.

5:7

Provides a harmonious 

and visually pleasing ratio 

to the human eye. More 

elongated than 4:5, it offers 

better scope for wide 

landscapes.

16:9

This panoramic format, 

has become popular in 

film and cinematography 

since the introduction 

of ‘widescreen’ TVs and 

computer monitors.
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UT R EF E A

apturing the horizon line 

straight is a classic approach 

in photography of all genres. 

By doing this, the composition gains a 

sense of balance and harmony, which is 

beneficial for subjects such as the sea, 

but this can also result in a standard 

frame that lacks dynamism. 

In this case, the so-called ‘Dutch 

C

SHOOT OFF-LEVEL
Create dynamic compositions using the Dutch angle

GOING DUTCH 

When travelling through a city by car or 

train, make use of viewpoints that add 

fresh dynamism to your frames

1PRIORITISE SETTINGS 

Shoot in M mode to control focus and blur. 

To improve the overall sharpness, work with 

apertures around f/8. This aperture is known 

to be the sharpest of most lenses. To reduce 

the risk that your subject gets affected by 

motion blur, choose a shutter speed of 1/500 

second. This setting depends on how fast the 

vehicle in which you’re sitting is going, and 

might need to be adapted to your situation. 

As we selected a fast shutter speed, the 

amount of light reaching the sensor is reduced. 

Compensate the exposure with higher ISO 

settings – here, modern cameras perform 

well to a greater extent without creating any 

distracting image noise.

2ENSURE STABILITY AND SHARPNESS 

When you’re on the move, it’s natural 

that the camera will shake from time to time, 

so it’s important to activate settings that 

support your stability. Go into your camera’s 

menu and enable the vibration reduction 

(VR) feature. Because of the movement, 

another challenge is to master the subject’s 

focus. To do so, avoid manual focusing, as 

this will take too much time and won’t deliver 

accurate results. Instead, select to shoot in 

continuous focus (CF mode). Now, the camera 

continuously tracks the subject through the 

frame and automatically adapts the focus. 

This focus mode is often used for sports or 

wildlife scenes.

3SHOOT, SHOOT, SHOOT  
For the best results, activate your camera’s 

burst mode or continuous shooting mode. 

On this setting, your camera automatically 

records a series of pictures as long as you 

keep the shutter button pressed, and this way 

you’ll have a wider selection to choose from 

later. Some practical tips for a drive-by shoot 

are to use the side windows of the car, and 

to clear your view by lowering the window, 

if possible, so that you can avoid including 

dirt or light reflections from the glass in your 

composition. Bear in mind that having the 

seatbelt on might limit your movement, but 

staying safe is more important than being able 

to move freely.

CHANGE YOUR SETTINGS Use your camera’s settings to help you get the best compositions

angle’ is a clever approach to convey the 

mood of a scene further. To apply this 

technique, tilt the camera to one side 

(either left or right) so that the horizon or 

other leading lines aren’t straight. The 

number one rule here is to make the 

tilt obvious, otherwise it can look like a 

mistake, and risk creating the impression 

of a low-quality image. 

This approach is 

especially powerful 

when you have 

a subject that’s 

moving in front 

of your lens, 

and even better 

when the subject 

is interacting 

with you, and 

the Dutch angle is 

often seen in travel 

photography to convey 

the feeling of movement and 

adventure. When travelling, some 

scenes typically will only be available 

to photograph on the go, for example 

from a moving train or car, so to keep 

the subject sharp you need to take 

some camera settings into account. 

Nevertheless, these compositions do 

not have to be as clean as those you may 

be used to creating. Cut off elements, 

such as part of the streets or a lamppost, 

to add interest to the frame and convey 

the mood. Additionally, having those 

elements out of focus contributes to the 

travel character of the photograph.

BE 

EXPERIMENTAL
When it comes to creating 

engaging compositions, the 

key is to let go of basic tried-and-

tested strategies. By doing so, you will 

explore the full range of possibilities 

the scene offers. A good exercise is to 

limit yourself to one subject, and shoot it 

with different framing approaches. By 

analysing the images, you can train 

your compositional skills and 

gain experience for the next 

scene you capture.
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UT R EF E A

hen photographing a subject, the 

most natural perspective is usually 

from a standing position, which 

gives a well-known and realistic view of 

the subject. However, this view may limit 

composition possibilities and the hidden 

qualities of the scene. To create a different 

kind of composition, vary the camera’s 

level to avoid missing out on engaging 

perspectives. By lowering or raising the 

camera, you can provide a fresh view of 

well-known scenes and gain composition 

possibilities that the eye-level perspective

simply can’t offer.

When going down low or looking up, use 

your camera’s tilted screen to make the 

process easier. By placing the camera on 

the ground, leading lines are created while 

structures of the elements gain importance, 

giving the frame more depth. For instance, 

when shooting from a low perspective in 

the city, road lines turn into leading lines, 

directing the viewer’s gaze while adding 

dynamism to the composition. 

Another technique is to involve 

foreground elements such as high grass in 

the composition to add layers and colour. 

Here, it’s essential not to overload the 

frame, which can distract attention from the 

main subject. Instead, work with maximum 

open apertures (low f-stop numbers) and 

position the camera close to the foreground 

element to be able to shoot through it. 

This approach adds colour and depth 

to the composition, offering the viewer

an atmospheric glimpse of the scene 

while still keeping the focus on the main 

subject. Lowering the camera also gives 

the foreground and background further 

significance within the composition, as the 

middle ground becomes less visible.

Pointing the camera 90 degrees up 

highlights the scene’s structure and 

form. This is particularly effective when 

capturing architecture or indoor features, 

as the scene gains abstract characteristics. 

To create a balanced composition, keep 

an eye on how the lines come together. 

Positioning yourself directly under the 

main feature ensures that the symmetries 

are showcased best. For such shots 

it’s helpful to activate in-camera grid 

lines, and correct any lens distortion in 

post-processing.

W

GO EXTREME
Leave the common eye-level perspective, and 

explore further composition possibilities

LOOK UP

Discover the 

potential  of 

architectural 

features to create 

compositions with a 

unique character 
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UT R EF E A

o create a striking composition, 

consider whether your scene 

contains elements that appear in 

the form of patterns. Such sequences are 

harmonic to the human eye, but are often 

overlooked in busy situations. There’s 

a theory that including even numbers 

of elements can have the effect of 

distracting the viewer. On the other hand, 

odd numbers are thought to engage the 

viewer’s attention, as these are visually

appealing and look more natural to the 

human eye. Also, integrating objects in 

different colours or shapes breaks the 

composition’s pattern and adds interest.

To create eye-catching graphical 

compositions, experiment with the angle 

and framing. For example, photographing 

from an elevated viewpoint captures 

the scene in a so-called bird’s-eye view 

to reveal patterns most people won’t 

notice in their daily lives. Next, look 

for interaction between elements: do 

they create a repetitive pattern or do 

they supplement each other in size and

colour? If the scene offers a pattern, 

for example in the form of tiles or 

windows, it’s recommended to extend 

the sequence beyond the frame. If there

is no obvious pattern evident, crop the 

frame tightly so that objects of similar 

colour or form align. To capture the 

pattern straight, dive into your camera 

menu and activate the grid lines. This 

T

SEARCH FOR SEQUENCES
Concentrate on integrating patterns to create powerful graphic compositions

LEADING LINES
Leading lines are a powerful 

tool to create engaging and 

visually appealing compositions, as 

they draw the viewer’s attention to the 

subject. However, it’s important to use them 

to your advantage, or you risk leading the 

viewer’s gaze to uninteresting parts of the 

frame. When composing the photo, start

by arranging the subject first, then adjust 

your compositions so that lines in the 

image either originate from or end 

at the subject’s position.

way, you can level the composition to 

perfection without the need to spend 

time on corrections in editing. 

To underline the graphical effect, 

consider transforming the colour scheme 

into black and white in post-processing, 

with the absence of colour enhancing 

the detail in the patterns. When doing 

so, focus on enhancing the overall 

contrast, as with greater contrast the 

image elements gain new visual aspects 

and importance, letting the daily scene 

appear unnatural and generated. Instead 

of setting the image mode to grayscale, 

add a Black & White adjustment layer, as 

that way, you won’t lose the control over 

tonal adjustments.

ALL SQUARE Patterns can be easily overlooked, so it’s important to take time to study the environment from different viewpoints 
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UT R EF E A

acial impressions can 

contribute to the effect of a 

photograph, but often distract 

the viewer. To prevent this artistically,

shoot around lunchtime to make use of 

hard shadows that can hide people in 

the composition. This can be achieved 

by placing the shadows at around the 

height of the person’s face. 

For a more abstract approach, 

integrate the person’s shadow into 

the frame. This creates an interesting 

composition where the subject is not

physically present in the shot. This 

technique isn’t restricted to people, 

as shadows of other subjects also 

add another layer to the composition. 

To have further control over the 

scene, work with your own shadow. 

This works best by facing the camera 

downwards with a non-cluttered 

ground. To add interest and depth, 

choose a surface of sand or stones 

to reveal extra texture. 

F

THROW SOME SHADE
Use the sun’s power to create high-contrast 
compositions and partially hide your subject

SHADOW FACE

When taking a closer look, certain 

facial shapes are discernible. Due to 

the shadow placement the subject’s 

identity is a mystery, and doesn’t 

distract the viewer from the image

DEFINED SHADOW

The shape of the shadow is 

almost perfect, except for a 

slight loss of definition on the 

left side, indicating that it was 

present in the scene and not 

edited, making the frame real

FRAME DIVISION

The image was split diagonally

into two parts by the hard 

shadow, adding a sense of 

dynamism and interest while 

drawing the viewer’s eyes 

toward the centre of the frame
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UT R EF E A

ncluding a sub-frame in the 

composition offers the viewer a 

window to explore the subject 

in a more targeted way. This technique 

adds a layer of storytelling and context, 

allowing the viewer to explore the subject 

more intimately. It’s also effective for

controlling compositions on wider aspect 

ratios, as it’s ideal for filling unwanted 

space or obscure distracting elements. 

Any object that creates a second frame 

at the edges of the image can be used 

as a framing tool. 

The more unique the shape of the 

sub-frame, the more visually striking 

the composition can be. Overhanging 

branches, arches, and tunnels can be 

used to direct the viewer’s gaze toward 

the subject. Even nearby elements, 

such as fencing can act as a framing 

tool – when positioning yourself close 

to struts, integrate them into the left and/

or right sides of the image.

When creating a frame-in-frame 

composition, it’s important to consider 

the symmetries between the different 

elements of the image. If this is not taken 

into account, the composition will take 

attention away from the subject. To create 

a harmonious scene, pay attention to your 

I

FRAME THE FRAME
Look out for man-made or natural surroundings that border the scene

THINK MONOCHROME 

When capturing high-contrast scenes, 

enable the black and white preview in 

your camera settings to visualise the 

scene without colours

THINK TWICE

Although there might be 

creative composition strategies 

you want to finally put into action, 

don’t make the common mistake of 

applying these to a scene that will not 

benefit from it. A framing tool is not a 

subject, so following a subject-first 

approach is key to ensuring that 

frames have a purpose while 

highlighting the subject.

point of view. Position yourself parallel to 

the subject so that the scene’s form and 

shapes are equally involved. It’s worth 

experimenting with the camera height; for 

example, lowering the position adds depth 

and creates leading lines that guide the 

viewer towards the subject of interest.

A common challenge when using 

this composition strategy is getting the 

exposure right. If the sun is not directly 

behind you, the sub-frame may appear 

darker than the subject. One way to deal 

with these high-contrast scenes is to 

expose for the highlights or the midtones.

This way, lighter image elements aren’t 

overexposed and will display some 

details, while the darker elements lose 

all the detail. By doing this, any people 

passing by in your frame will also appear 

as a dark element, close to a silhouette.

A second approach is to apply the 

HDR technique to blend multiple frames 

with different exposures, enhancing the 

dynamic range and allowing for both 

bright and dark elements to be captured 

with more detail. This technique will 

usually require using a tripod so that you 

can ensure a smooth blending process.

However, if you can’t use a tripod and 

have to capture those scenes on the go, 

your camera has a range of features that 

will help you.
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plitting the composition into parts is a simple yet 

clever way to create an eye-catching composition. 

The most straightforward approach to achieving 

this is to work with two sides of the scene. As this technique 

presents the scene in a more structured way and slows 

down the pace of the composition, the scene appears more 

appealing to the viewer. 

To further enhance the visual impact of the composition 

and prevent it from appearing overloaded and cluttered, it’s 

essential to integrate some negative space into the frame. 

This allows the separate parts to breathe, creating a more 

balanced look. To achieve the maximum effect, the single 

parts of the composition should work well on their own but 

also reinforce each other. To determine whether a scene 

offers potential for implementing this technique, analyse the 

subject’s lines and change your viewpoint, allowing you to 

find the most advantageous angles and perspectives. 

Dividing tools do not only have to be physical elements; 

shadows are also great features to integrate. Capturing well-

defined and hard shadows adds further elements to the 

scene that can be used creatively to divide the composition. 

S

DIVIDE THE SHOT
Draw a line to break up your composition

FRAME OF MIND

When dividing the 

composition, including 

reflected elements of the 

scene is a clever approach to 

add creativity to the frame 

1
SHOOT IN AV 

To ensure the sharpness and depth of field 

aren’t affected by auto changes in aperture 

values, set your camera to aperture priority 

(Av) mode. It’s best to choose wider apertures 

such as f/8, so that a decent amount of light 

can reach the camera sensor.

4
ACTIVATE BRACKETING 

Go into the camera menu and select the 

auto exposure bracketing feature, found in the 

Drive shooting menu. Now, select the number 

of frames and the exposure values. Selecting 

2.0EV and three shots is suitable for most 

scenes.

2
INCREASE ISO 

To reduce ghosting, increase the ISO values.

This enables the camera to work with faster 

shutter speeds and supports a close series 

of handheld frames, resulting in fewer frame 

deviations for a smooth blending process in 

HDR software.

5
MERGE HDR 

Upload the images from your card to your 

editing device. Merging an HDR image is 

possible in most advanced editing programs. 

You can locate this function In Photoshop 

under File > Automate > Merge to HDR Pro.

3
STAY STEADY 

Enable image stabilisation in the camera 

menu and lens, and check whether the scene 

offers any extra support, for example, walls 

that you can lean against to help reduce 

camera shake. For greater stability, choose the 

viewfinder over the LCD.

6
FINE-TUNE HDR EXPOSURE 

First, concentrate on Basic sliders. Adjust 

settings to your liking, and avoid increasing the 

Detail slider to achieve a natural result. Under 

the Advanced sliders, adapt Shadow, Highlight, 

Vibrance and Saturation settings.

SHOOT HANDHELD Can’t set up a tripod? Here are some tips for shooting handheld

For instance, shooting the scene around midday when the sun is 

at its highest point helps capture these shadows to create a more 

interesting and dynamic division.
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UT R EF E A

hen capturing large subjects, 

such as architecture, one 

commonly used technique 

is including a person in the frame to 

highlight the size and scale of the 

building. This person can also act as 

an indicator of reality, because when 

you’re capturing architecture with long 

exposures or an overcast sky, the natural 

element of the horizon can come across 

as surreal and animated. 

To extend this composition technique 

further, you can also integrate elements 

in such a way that they don’t give any 

clues as to the actual scale of the scene. 

Using this approach, play with the 

subject’s proportions, making subjects 

appear larger or smaller than they really 

are. This strategy is popular in travel 

shots, with tourists creatively integrating 

themselves into shots of well-known 

landmark such as the Eiffel Tower or the 

Leaning Tower of Pisa.

To apply this composition, it’s best

to work with two subjects in the frame. 

One subject needs to be physically more 

distant from the lens, while the other 

one is positioned close to your optic. 

To bring creative ideas to life, it’s helpful if 

you’re able to move or direct at least one 

subject, as this will enable you to actively 

arrange the subject to match your vision. 

This approach also can add a layer of 

humour, when mismatched elements are

brought together for instance. Subjects

that at first glance don’t have much 

W

PLAY WITH PROPORTIONS
Challenge the viewer by placing subjects in a targeted way

DOG DAYS

Incorporate multiple layers 

of interest to engage the 

viewer on a deeper level

LIMIT YOURSELF

Imposing limitations on 

yourself is a great way to push 

yourself and enhance your creative 

composition skills. One example of 

this is limiting your lens’s focal length. 

If you don’t have a prime lens, manually 

fix a specific focal length on your zoom 

lens with a piece of tape. This will 

encourage you to think outside 

the box, and explore different 

angles while discovering 

new possibilities.

connection to each other can make a 

powerful combination that forces the 

viewer to think about the image. 

As the distance between your two 

subjects will likely be significant, keeping 

both sharp will be a challenge. To widen 

the depth of field, work with narrower 

apertures of greater than f/11. If you’re 

struggling to achieve uniform sharpness, 

adapt the differences between the 

subjects by changing focal length, or 

consider focus stacking.
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UT R EF E A

hen it comes to telling a story in 

your image, the composition plays 

an essential part, and working 

with reflections is an effective way to add 

a layer to the frame, which contributes to 

enhancing the mood while providing the 

viewer with the context of the scene. 

Mixing reality and reflection in the 

composition leaves the viewer with 

a lasting impression, and capturing 

reflections of the subject in water opens 

up possibilities to include other elements 

in the frame. When creating such images, 

keep an eye on the weather and speed of 

the water flow; calm surfaces work best to 

capture clear reflections of a subject. 

Windows are another reflective surface 

that offer great possibilities. Here, shop 

or restaurant displays are good options, 

as those windows usually extend over a 

large area. This way, you can integrate the 

elements found behind the windows with 

contrasting scene elements like trees, 

shops, and passers-by. Car windows are 

also a great tool to bring this composition 

strategy to life.

To enhance the creative possibilities of 

windows, change the viewpoint and shoot 

through them. Raindrops on the surface, 

for example, will leave you with an 

interesting additional element, enhancing 

the frame’s mood. To take this further, 

experiment with shifting the focus. Go to 

your camera menu and select a flexible 

focus point, which you can either direct 

through touch or buttons to the specific 

element. To have the raindrops appear 

sharp while letting the background appear 

blurred, work with maximum aperture 

settings and longer focal lengths. When 

zooming into the raindrops, you’ll notice a 

sharp reflection of background elements. 

There are endless possibilities 

when it comes to using reflections 

in compositions, and being creative

and experimental will open up new

opportunities to enhance the visual 

storytelling experience.

W

ADD LAYERS
Create a story by combining fragments of scenes in one frame

MYSTERY SUBJECTS

Although only the reflection of the 

subjects is visible in the frame, their 

outlines hint at the appearance of 

these people without distracting 

from the image

FRAMING ELEMENTS 

By integrating the branches in 

the upper part of the frame, the 

dead space was reduced and 

interest and colour added

STILL SURFACE

The surface of the water is 

mostly calm, although its 

movement is suggested at the 

bottom-right. Reflections from 

the sky add a smooth gradient 

throughout the frame
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UT R EF E A

PRO ADVICE
Divyanshu Verma on how he brings his compositions to life

DIVYANSHU VERMA

A self-taught 

photographer based 

in Uttar Pradesh, India, 

Divyanshu Verma has 

a passion for finding 

moments around him 

that help him see the world from a 

different perspective, and  his work has 

been recognised by various platforms 

both nationally and internationally. 

With his positive attitude, Divyanshu 

strives to create his own style and 

identity in this competitive world. 

divyanshuverma.net 

@street_ash

Divyanshu, what role does image 

composition play in your work?

As photographers, we all know that 

composition is vital. It plays an important 

role when it comes to creating an eye-

pleasing frame. In my work, the most 

important role it has is to create simplicity 

and to balance the scene; because the 

simpler the scene is composed, the more 

pleasing it usually looks. I always aim 

to highlight the main subjects so that 

distracting objects seem to be negligible. 

The most important aspect is the 

essence of the composition, like the 

arrangement of elements in the frame. 

Here the well-known ‘rule of thirds’ 

comes into play. It’s one of my favourite 

techniques that I learned when starting 

my photography journey. This classic 

rule clearly highlights what to add to 

the frame to create simplicity and an 

attractive composition. Placing the 

subject at one of the intersecting points 

supports dividing the image both 

horizontally and vertically, and it also 

helps to create balanced detail.

How do you decide on your 

final composition? 

When I choose the compositions for 

my images, I keep the ‘rule of thirds’ in 

mind. However, to create the perfect 

composition, I sometimes break this rule, 

depending on the message I want to 

convey. Next to this, perspective is vital 

in my work. It has the power to create 

a magic touch, so experimenting with 

different angles helps to create perfect 

compositions with a sense of depth. 

In some of my images, I use leading 

lines to lead the viewer’s eyes directly 

towards the subject, and to add extra 

depth and interest, I include shapes and 

textures in the scene. 

There are three key things I keep in 

mind when I compose an image. First, I 

decide how much background I want to 

integrate into my frame. This way, I can 

avoid creating distractions and exclude 

any unnecessary elements. Second, 

I always avoid my subject becoming 

merged with the background, and third, 

I try to change my angle to add an 

artistic touch to my images; this also 

helps me to separate my subject from 

the background.

Do you have any tips for aspiring 

photographers on how to create 

captivating compositions?

I‘ve seen many beginners facing 

the problem of how to compose 

their subject within the frame. It also 

challenged me in the earlier days of 

my career, but I practised a lot, and 

that helped me to compose better 

photos over time. So my advice is to 

keep practising and experimenting. 

Secondly, always go for an interesting 

subject, or incorporate your subject in 

an interesting place. My third tip is to 

use different and creative perspectives 

to make the scene look interesting. 

Also, try to fill your frames to create 

extra depth, but avoid cutting off 

important image elements. Lastly, 

play with different lighting to create a 

powerful mood and feel to underline 

the composition.

MIST OPPORTUNITIES

Divyanshu captured his 

hometown of Prayagrah during 

the winter. “Due to the fog, the 

mood and the feeling was special 

that day,” he says
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AVAILABLE ON YOUR DEVICE NOW!

To find out how you can get Photography Week delivered straight  
to your device every week for just a few pennies, simply search  

for Photography Week on any of the platforms below

SUBSCRIBE TODAY AND ENJOY
PHOTOGRAPHY WEEK FOR
JUST 39C/39P AN ISSUE*  

S U B S C R I B E

http://bit.ly/2txbB2Bhttps://apple.co/2RjoI0a http://bit.ly/36kQ7TC

*Available for a limited time only. Standard subscription offer varies across platforms/devices – please refer to specific store for the most up-to-date offer
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XPOSURE
THE WEEK’S MOST INSPIRING READER PHOTOS

EL R YG A L

COLOUR BENDER 
RUBEN ALEXANDER

 “This was one of my initial attempts at glassware photography. There’s more 
to glassware photography than meets the eye, and it’s a very challenging 

genre. I used the principle of refraction to create this image.”
https://bit.ly/4a0dqnC
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THE WEEK’S MOST INSPIRING READER PHOTOS

EL R YG A L

MOMMY DEEREST
TOM MORTENSON

“A tender moment between a mother white-tailed deer and 
her young fawn. Taken in Portage County, Wisconsin, USA.”

https://bit.ly/3EykdWb
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THE WEEK’S MOST INSPIRING READER PHOTOS

EL R YG A L

AFTER THE SUMMER
NICK STRONG

“I took this shot of some conkers in my home studio using LED lights.”
https://bit.ly/3tXh6GI
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RAME HEAD SUNSET
HOWARD PRATT

“I captured this striking sunset over Rame Head in southeast Cornwall, 
UK. At one point I didn’t think it was going to be very impressive.”

https://bit.ly/4agEY8E

THE WEEK’S MOST INSPIRING READER PHOTOS

EL R YG A L

PHOTOGRAPHY WEEK WANTS YOUR PHOTOS! 
Taken a portrait you’re particularly proud of? Shot a sensational sunset you’d like to 
show off? Then join the Photography Week Facebook community and share your best 
photos today! You’ll get feedback from fellow readers and the Photography Week 
team, plus the chance to appear in Xposure, or even on our cover!

FACEBOOK

http://bit.ly/39py9lg

FLICKR 

http://bit.ly/2VIgsJO
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he World Photography Organisation 

has revealed the overall winners of 

the 2024 Sony World Photography 

Awards, showcasing an outstanding 

collection of images from some of the 

world’s leading photographers.

The awards are one of the world’s biggest 

photography contests, with Professional, 

Open, Student, and Youth competitions, 

plus national, regional and specialist awards. 

Subject categories include Environment, 

Prestigious contest celebrates outstanding photography from around the globe  

Portraiture, Wildlife & Nature, Still Life, and 

Landscape. The overall winners of the main 

competitions receive cash prizes plus Sony 

imaging equipment.

Juliette Pavy was awarded Photographer 

of the Year for her documentary series 

highlighting the forced sterilisation of 

women in Greenland. Click the link to see 

the winning and shortlisted images from 

all the categories at the awards website, and 

for details of exhibition dates and venues.

I T ’ S  C O O L ,  T H AT
THE BEST THING WE’VE SEEN THIS WEEK

I N S P TI R A OI N

SONY WORLD PHOTO AWARDS 
ANNOUNCES 2024 WINNERS

T

Thomas Meurot, Winner, Professional Competition, Sport Kathleen Orlinsky, Winner, Sustainability Prize

Jorge Mónaco, Winner, Professional Competition, Portfolio Liam Man, Winner, Open Photographer of the Year
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s any photographer worth 

their salty tripod legs knows, 

sunrise and sunset are good 

times to head to the beach 

with your camera. When the sun goes 

low and reflections tint the water, we 

can be treated to some of the most 

gorgeous sights of the great outdoors. 

But the best sunset photos capture 

more than just bold clouds and vibrant 

colours – what we need is a subject to 

frame against the sky. Because of the 

stark contrast between the sky and 

foreground, it’s often impossible to 

record detail in both; but instead, we 

have the opportunity to capture bold 

silhouettes.

You can have all kinds of fun crafting 

playful silhouetted portraits, and in this 

project we’ll show you how to shoot for 

a striking stitch. This involves capturing 

our subjects in lots of different positions 

around the frame, shooting a variety of 

poses and bringing in different props. 

By using a tripod to keep all the frames 

aligned, it’s a simple task to then 

combine the best poses into an 

eye-catching array of silhouettes.

Whether you want to combine 

portraits or capture a single frame at 

sundown, you’ll learn lots of tips and 

tricks. We’ll look at the ideal camera 

settings, the best angles, and posing 

suggestions. You’ll also find editing tips 

on how to bring a set of poses together, 

and a Photoshop guide in the video.

A PLACE IN THE SUNSET
James Paterson shows you how to shoot and combine 

images to create striking silhouette composites

C R A S H  C O U R S E 
ESSENTIAL PHOTO SKILLS MADE EASY

S K I L L S

A

WATCH THE V IDEO 
ht tps : / /b i t . l y/3TXu jbu

A series of silhouetted figures  

contrast against the clouds to 

really stand out on the beach
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HOW TO SHOOT SUNSET STITCHES

S K I L  L  S

1  SHOOT INTO THE SUN
The best sunset colours usually appear 

around the direction of the setting sun. 

Here it meant turning away from the sea 

towards the land, but if you can get an 

angle with the sun setting over the sea, 

even better. Often the best sunsets occur 

after a storm or a rainy day, as the clouds 

will be lower and heavier.

4  EXPOSING FOR  
 SILHOUETTES
Shooting in manual exposure mode is 

best for sunset portraits, especially if 

you want to combine several frames, as 

it keeps things consistent. Here we’re at 

aperture f/4, shutter speed 1/400 sec, 

ISO160 – a fairly fast shutter speed such 

as this will freeze the motion.

3  GET LOW WITH  
 A TRIPOD
If you want to stitch together a set 

of silhouetted portraits you’ll need a 

tripod to keep all the frames in alignment. 

A low camera angle is ideal, as it gets the 

camera closer to the puddles for better 

reflections and frames the subjects 

against the vibrant sky.

6 WIDE-ANGLE LENS
A wide-angle lens is ideal for a sunset 

stitch as it lets us frame low to the ground 

and exaggerate the perspective with 

reflections and foreground details. It also 

means we can frame fairly loosely, and 

concentrate on posing rather than having 

to keep an eye on where the subjects are 

in the frame.

2  AT THE BEACH
A wide flat beach is ideal for this, 

especially if there are pools and puddles 

of water to reflect the sunset sky. Look 

for a beach with an expanse of sand, 

like our shot here at Dymchurch, Kent. 

Time your visit so that the tide is out, as 

this way you’ll achieve pristine sand and 

puddles for reflections.

5  SET A HIGH  
 DRIVE MODE
Time is short, as the sunset colours 

fade quickly and the clouds may move, 

which can cause a problem later on 

when combining photos. So a rapid fire 

approach is best. Engage continuous 

drive mode, and shoot more frames than 

you need, capturing the subjects in all 

parts of the image.

1

2

3
4

5

6

Learn how to shoot a set of silhouetted portraits at sunset
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TOP TIPS FOR STRIKING SILHOUETTES

S K I L  L  S

UNDEREXPOSE THE SUBJECT
Underexpose the subjects so they come out 

dark and you get a bold, vibrant sky. A sunset 

can look better than it does to the naked eye 

when underexposed, so take test shots and keep 

things dark. Use the histogram to ensure that the 

highlights aren’t clipped.

LOOK FOR CLOUDS
A bit of cloud cover is usually best, as if the sky is 

too clear then the sunset can look dull. Scattered 

high clouds are ideal – if they’re too low, they’ll 

block the sun at the critical moment as it dips 

towards the horizon. There are lots of sunset apps 

to help you predict when a good one will appear.

2

1

SHOOT LOTS OF POSES
We shot a set of photos here while the kids ran, 

jumped and skipped around the beach. When 

the sun sets you won’t have much time, so plan a 

few poses in advance. If you have more than one 

person in the frame try to separate the poses so 

they are not overlapping, and shoot them side-on 

for strong shapes and profiles.

3
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TOP TIPS FOR STRIKING SILHOUETTES

S K I L  L  S

SHOOT THROUGH  
STRIKING SHAPES

Try shooting through things like branches or 

fences to create strong silhouetted shapes. 

Here the camera is on the ground, and a wide-

angle lens exaggerates the perspective of the 

fence. It can be hard to visualise how objects will 

look in black, so engage Live View and use the 

camera preview.

USE PROPS
Use props for your silhouette portraits. Things 

like balls and sports kit are good for poses, as 

are bubbles and toys for kids – anything that 

makes an interesting shape or looks good in an 

action shot will work. Think about clothes too – 

you’ll want bodies to be clearly defined, so avoid 

bulky or baggy outfits.

5

4

CAPTURE MOMENTS 
OF EMOTION

Silhouetted portraits are ideal for capturing 

moments of poignancy or emotion. Sunset 

colours evoke a dreamy mood, and 

unidentifiable silhouettes have a universal 

feel, as they could be anybody. Have subjects 

interact with one another, perhaps with a 

cuddle, holding hands, or dancing.

6
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1  BOOST THE COLOURS
Highlight the set of images in Bridge, 

right-click and select ‘Open in Camera 

Raw’. Use the tonal sliders to fine-tune 

brightness, contrast and colours in one 

image, then hit Cmd/Ctrl+A to select 

the rest, right-click and sync your edits. 

Click OK, then go to Tools > Photoshop 

> Load Files into Photoshop Layers.

3 COMBINE SHOTS
Take the Brush tool, and paint white 

over the parts of the layer you want to 

reveal. Next highlight and reveal the 

next layer up, add a full mask again, and 

paint white to reveal the areas you want. 

Continue with this painting procedure 

until you’ve blended all the layers you 

want to use in your image.

2 ALIGN AND MASK
In the Layers panel, hold shift and click 

the bottom layer to highlight them all. 

Go to Edit > Auto-Align Layers, tick 

Auto and click OK to correct any slight 

misalignment. Next, hold Alt and click the 

eye icon on the bottom layer to hide the 

others. Reveal the layer above, then Alt-

click the Mask icon to add a full mask to it.

A setting or rising sun gives us the 

opportunity to shoot for a sunstar. Use 

a narrow aperture, like f/16 – you can 

sometimes create sunstars with wider 

apertures depending on the lens, but, 

in general, the narrower the aperture 

the stronger the star shape. That 

shape tells you something about the 

lens too. If it’s a six-bladed aperture, 

you’ll see six spikes on the sunstar. 

If the lens has an odd number of 

blades you’ll see double the number 

of spikes, so a nine-bladed aperture 

will result in a star with 18 spikes. 

Typically you’ll want to position the 

sun against a dark 

object like the 

edge of a person; a 

partially-obscured 

sun tends to work 

better, as it makes 

for a smaller point of 

bright light. The dark 

shape also gives you 

strong contrast with 

the bright sunstar.

Use a narrow aperture to create a 

sunstar effect as an extra bonus

HOW TO BUILD A SUNSET STITCH

S K I L  L  S

Combine your set of silhouetted portraits in 
Photoshop with simple layer-masking skills

SHOOT FOR A SUNSTAR
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PHOTOSHOP 
LEARN ESSENTIAL EDITING SKILLS FAST!

E D I T I N G

EXPERT TIP
You need to make your cutout and 

backdrop look like they belong together. 

Solutions include adjusting colours and 

tones, adding  a vignette or applying 

other filter effects. Another trick is to add 

a texture layer on top, using blend modes 

to combine it with the layers below. We’ve 

supplied 15 textures; drag them into your 

image and experiment with blend modes, 

opacity and masking.

Meet the filter that creates entire backgrounds based 
on a few words – James Paterson shows you how

f you’ve been paying attention 

to photography news outlets, 

you can’t have failed to notice 

the hype around AI image generation. 

Generators such as Stable Diffusion, 

Dall-E and Midjourney make it possible 

to create artwork from nothing more 

than a few words, and this has caused 

both excitement and apprehension 

among photographers, as the way 

these tools gather and reassemble the 

substance of existing photographs 

raises genuine concerns about 

intellectual property. But, whether you 

see AI as ground-breaking technology 

or a threat to traditional creatives, 

there’s no denying that we’re entering 

a new era of image-making.

Users looking to experiment with 

text-to-image generation will find an 

intriguing tool within Photoshop’s beta 

software (at the time of writing). As 

you’ll discover in this video tutorial, the 

Backdrop Creator Neural filter lets you 

create a whole new backdrop based on 

a prompt of just a few words. Of course, 

anything in beta isn’t the finished 

article, but it’s worth experimenting 

with the latest Adobe tools. Backdrop 

Creator is designed to work with your 

I

HOW TO...

GENERATE AI BACKDROPS

images, and, as such, it may offer a 

glimpse of how AI and photography 

can work together in the future.

DOWNLOAD THE
PROJECT F ILES 

https://bit.ly/4aEK26p

ON A PC  OR M AC

WATCH THE V IDEO 
ht tps : //b i t . l y /3W51SeH
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sigma-global.com £2,779/$2,999

his latest Sports-series lens 
aims to combine high-end 
handling and performance 

with a relatively manageable size and 
weight. The lens tips the scales at just 
1,370g – less than many 70-200mm 
f/2.8 ‘trinity’ zooms. It’s reasonably 
compact as well, measuring 108 x 
235mm, partly thanks to the f/5.6 rather 
than f/4 aperture rating, although it still 
has an oversized filter thread of 95mm. 
Even so, there’s no need to resort to 
drop-in filters, as featured in many 
super-telephoto lenses.

T

L E N S  T E S T
EXPERT OPINION ON THE LATEST KIT

This relatively lightweight lens packs a load of upmarket features

SIGMA 500MM  
F/5.6 DG DN OS SPORTS

VERDICT
It’s a great buy at the price, offering 

quality and portability. It’s just a 

shame that it’s not available in a 

wider range of mount options.

MOUNT: LEICA L, SONY E (FE) ELEMENTS/
CONSTRUCTION: 20 ELEMENTS IN 14
GROUPS ANGLE OF VIEW (DIAGONAL) : 5° 
MAX APERTURE: F/5.6 MIN APERTURE: F/32 
MIN FOCUS DISTANCE: 3.20M FILTER SIZE: 
95MM LENGTH: 235 MM DIAMETER: 108MM 
WEIGHT: 1,370G

Performance 

In keeping with the lens’s ‘Sports’ 
aspirations, it features a rapid HLA 
(High-response Linear Actuator) 
autofocus system, ideal for tracking 
the action in sports and wildlife 
photography. I found that autofocus 
was quick to lock on to subjects, and 
highly effective at tracking moving 
objects. The 5-stop optical stabiliser 
also earned its keep. As for pictorial 
quality, my dull-day images had 
plenty of bite, with excellent 
sharpness, contrast and clarity, and 
I’m impressed that levels of sharpness 
are both satisfying and extremely 
consistent from the widest aperture 
of f/5.6 down to f/11. Both axial and 
lateral chromatic aberrations are 
minimal, the latter being barely 
noticeable even at the edges and 
corners. And, unlike many mirrorless 
optics, this Sigma is a virtually 
zero-distortion lens, requiring no 
automatic in-camera correction.
Matthew Richards

The optics are sharp and colour fidelity

is excellent, providing punchy images. 

This quality is maintained right across the 

frame and through the aperture range

The 500mm focal length allows for tight 

framing of distant subjects and a nicely 

compressed perspective, although no Sigma 

teleconverters are available for this lens
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DIGITAL CAMERA WORLD
A monthly magazine that aims  
to improve your photography with  
an inspirational mix of amazing 
images and how-to articles.

N-PHOTO
N-Photo is a monthly magazine for 
Nikon photographers, and is packed 
with technique and Photoshop video 
lessons every month. 

DIGITAL PHOTOGRAPHER
The monthly kitbag essential for 
enthusiast and pro photographers, 
packed with tutorials, exclusive 
interviews and the latest reviews. 

PHOTOPLUS
PhotoPlus is a monthly magazine 
for Canon photographers that 
features expert advice, tips and video 
tutorials on all things Canon.

MORE GREAT MAGAZINES FROM  

THE MAKERS OF PHOTOGRAPHY WEEK

SA P P

http://bit.ly/30FoOlQ

https://bit.ly/3lH4ucX

https://apple.co/2vaIdzw

https://apple.co/2SJf6ff

http://bit.ly/3atHLfO

http://bit.ly/2RER7g6

https://apple.co/2TNE26T

https://apple.co/2RBrZqG
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